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Getting Started

Your Zoom™ Ethernet (10/100BaseT) cable modem is
designed to connect your personal computer to the Internet
through the same cable that you use for television reception.

Contacting Your Cable Company
Please fill out the information in the following table before you
begin installing your Zoom cable modem. Your cable service pro-
vider needs this information to ensure that your modem connects
to the Internet successfully. Note: This manual assumes that you
have already arranged for cable modem service and established a
cable modem account with your cable company.
Important Installation Information
The following information is located on the label on the bottom of your
modem. You will be asked to provide it when you call for installation.

Product Name: Zoom CableModem
Model: __________
S/N: _____ - _______ - ____ - _____ - ______

Cable Modem MAC Address:_________________

To connect your cable modem to the Ethernet port of your computer, you
will need the Ethernet card’s MAC Address. If you don’t know it or can’t

find it, see page 37 for detailed instructions.

Ethernet MAC Address:______________________

If you plan to use the cable modem with an Internet gateway, you will need
the MAC Address of its WAN port, which should be on the gateway’s label.

Gateway MAC Address:
etting Started 3
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Package Contents
In addition to this manual, check that your package includes the
following items. If you are missing anything, contact your dealer or
cable service provider.

• Cable modem

• Ethernet cable

• Power adapter

• Software on a CD-ROM

• Vertical mounting stand.

Modem

Ethernet Cable

Power Adapter

Software CD-ROM

Vertical
Mounting Stand
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You Will Also Need
To complete your installation, you must have these items:

• Cable modem service provided by your cable company. The
service must be DOCSIS- (Data Over Cable Service Interface
Specification) or EuroDOCSIS-compatible, where applicable.

• A computer running the Windows® 95, 98, NT 4.0, 2000, Mil-
lennium (Me), XP, or Linux operating system, or a Macintosh®

running System 7.5 or later.

• An Ethernet (10BaseT or 100BaseT) port in the computer you
want connected to your cable modem. If your computer
doesn’t have an Ethernet port, you will need to buy a Network
Interface Card (NIC) and install it before completing the cable
modem setup. Some cable operators offer the option of pro-
viding and installing the NIC card.

• A power outlet.

• A 75-ohm coaxial cable that will connect to the cable TV sys-
tem and that can reach to where you intend to place your cable
modem.

Note: Because there is great variety in the way cable is installed,
Zoom does not provide a coaxial cable to connect your
modem to your cable system. Your cable company may
provide the appropriate length cable for your use. If the
company doesn’t supply the cable, you should buy a coax-
ial cable with an RG-59 or RG-61U rating (75 ohm) and
industry-standard F connectors.

Tip: For best performance, do not use “push-on” F con-
nectors; use only “screw-on” F connectors.
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Familiarizing Yourself with Your Cable
Modem

Your Zoom cable modem has several LED light indicators on its
front panel, so you can monitor its operation and perform trouble-
shooting if necessary.

The following table defines these lights and explains how to inter-
pret them. This table is for reference only and is not required for
cable modem installation.

LIGHT NAME MODE STATUS
READY Lit Power is on.

SYNC Blinking
Fast

Searching for “data” channel from
the cable provider.

Blinking
Slow

Ranging (synchronizing the signal
for optimum performance) and
Registering (signing on to the cable
company’s network).

Steady
(Lit)

The modem is synchronized to the
cable system.

ACT Blinking Data activity is present on the cable.
The cable modem is communicating
with the cable system. It may be
downloading data or uploading data
to the cable service provider and the
Internet.

10BT Lit The Ethernet (10/100BaseT) com-
puter interface is connected.

The back panel of your cable modem looks like this.
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When you connect your cable modem, all connections will origi-
nate from this back panel. Continue with Chapter 1 (page 8) for
installation instructions.

If you would like to use your cable modem with multiple comput-
ers, you can do so by adding a hub, router, or gateway. Zoom of-
fers gateway/routers that work with your cable modem. You will
also have to contact your cable service provider.
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1
Installing Your Cable Modem

Note:Note:Note:Note: If your cable company provides you with an installation
procedure, follow it instead of the instructions in this
chapter.

This chapter describes how to connect your Zoom cable
modem to a computer and to your cable service.

Installation consists of a few simple steps:

1. Install any software required.

2. Make the physical connections to your cable modem.

3. Provide your cable provider with the proper MAC
addresses (if necessary).

Installing the Cable Modem Software
Install your cable modem software first, before connecting the
modem hardware. Follow these steps.

1 Your computer should be on. Insert the Zoom CD into your
computer’s CD-ROM drive. The CD will start automatically.
(If it doesn’t, from the desktop, go to Start | Run and then
type d:\setup.exe, where d: is the letter of your CD-ROM
drive.
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2 When the main menu appears, click Cable Modem Installa-
tion Wizard.

Be sure to read the Prepare to Install directions, take action
as needed, and then click Continue.

3 When the Choose Your Modem dialog box displays, click
Ethernet External Cable Modem.
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4 The Zoom PC Resource Checker checks your computer to
verify that it has appropriate resources to support your cable
modem model. You will see a screen similar to the one below.

• If your computer has the recommended resources, click
Continue to proceed.

• If your computer does not have the recommended re-
sources, click Details and follow the instructions to rectify
the problem.

5 The Setup Wizard continues the software installation process.

6 When prompted, click NO, I will restart my computer later,
and then click Finish.

Be sure to remove the CD from your computer when you’re
done.

7 Shut down your computer.

The next stage is to connect the hardware.
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Making the Connections
Connecting your cable modem is simple. Typical connections are
shown below.

Power
Adapter

Coaxial
Cable

Ethernet
Cable

Tips:

✔ If you are using the mounting stand and find that the modem
is top heavy with the coaxial cable connection on top, turn the
modem over so that the coaxial cable connection is on the
bottom.

✔ Your service provider may advise you that a splitter, amplifier,
and high-pass filter are required. The Troubleshooting ap-
pendix includes a diagram illustrating such a setup (page 28).
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CAUTION: Place the modem so that there is one inch of free
space between its top and sides and any other de-

    

    

1

2

3

Zoom Cable Modem User’s Manual

vice or the wall. Do not block the vents in any way.
Failure to allow proper air circulation can result in
serious damage to the modem.

                    Do not place any items on top of the modem while
it is on.

                    Do not place the modem near a heating or air con-
ditioning duct, in direct sunlight, or anywhere sus-
ceptible to drastic temperature changes.

 Plug one end of the Ethernet cable into the Ethernet jack on
the rear of the modem and the other into the Ethernet jack on
your computer.

 • If you have a wall outlet cable jack, connect one end of the
coaxial cable to it. Connect the other end of the cable to
the Cable connector on the back of the cable modem.

• If you don’t have a wall jack, you should have a length of
coaxial cable entering your house close to where you want
to locate your cable modem. Connect the end of this cable
to the Cable connector on the back of the modem.

 Connect the power cord. Insert the small round end of the
power cord into the Power socket on the back of the cable
modem. Plug the power adapter into the wall socket.
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4 Restart your computer.

You should see a dialog box similar to the one below.

Note: If this dialog box does not display automatically, go to
Start |Programs |Zoom Cable Modem |Cable Modem
Monitor.

Select your computer’s Ethernet NIC card from the drop-
down list and click Next.

5 The following dialog box displays.

Click Restart System.

The modem starts an automated power-up process that is de-
scribed on page 14.

Note: The Resource Checker, User Manual, and supplementary
software are also installed on your computer during this
installation procedure. For removal instructions, see page
23.
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The Modem’s Power-Up Process
As your cable modem powers itself up, the lights on the front
panel indicate the different stages. When the modem initially pow-
ers itself up, the PWR light comes on. After completing a self-test,
the cable modem registers with the cable system. While the modem
is searching for and registering with the cable system, the SYNC
light blinks: At first the light blinks fast; then it blinks slowly. After
the process is complete, the SYNC light stays on steady. (The table
on page 6 lists the LEDs and their modes.)

Note: It may take several minutes for the modem to register with
the cable system.

After the cable modem is connected, the 10BT light comes on.
This indicates that the cable modem and the computer’s data inter-
face are linked.

If you do not see the 10BT light on, double-check to see that the
Ethernet cable is securely inserted in the proper jacks on the cable
modem and computer. The PWR light must be on before the
10BT light will come on.

Note: If you experience an outage with your cable TV service,
your cable data connection will most likely also be off. If
you are unable to connect to the Internet, or if your
browser notes that it is unable to find a selected URL,
check to ensure that you have cable TV service available.
If not, contact your cable service provider.

At this point, the system at your cable company will communicate
with the modem and computer to finalize the installation. This part
of the installation varies from company to company, so you should
follow the directions that are given to you.

In some cases, the cable company will automatically query the cable
modem via the cable connection. In other cases, your cable com-
pany may have instructed you to phone back with your cable mo-
dem’s MAC address once you completed the hardware installation.
The cable company may need the cable modem’s MAC addresses
(located on your cable modem’s label), or request billing informa-
tion. Refer to the table on page 1.
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The Next Step
If you are like the majority of users, your cable modem installation
is complete. Turn to Chapter 3 (page 19) to learn how to use your
modem. The exceptions are as follows:

• Your Internet browser setting may need adjustment. If you are
unsure, turn to Chapter 2 (page 16) for advice.

• If you are using Windows 95, or if you are a Macintosh or Li-
nux user, your computer’s network settings need to be config-
ured. Turn to page 29 for instructions.
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2
Configuring Your Browser

An Internet browser is a program used to find and display Web
pages. To find a page, the browser must connect to the Inter-
net, either via phone lines or a LAN (Local Area Network). If
you are using a cable modem, your browser needs to connect
to the Internet via a LAN. This chapter describes how to config-
ure some of the most common Internet browsers. It is beyond
the scope of this manual to give step-by-step instructions for all
versions of all browsers, so the instructions below cover only
the major versions of the most common browsers. If you are
using another browser, please consult the documentation that
came with it.

Internet Explorer 4.0

1 Start Internet Explorer.

2 Open the View menu and select Internet Options.

3 In the Internet Properties dialog box, click the Connections
tab.

4 Click Connect to the Internet using local area network, and
click OK.
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Internet Explorer 5.x or Later

1111 On the desktop, click the Internet Explorer icon.
If you cannot access the Internet Explorer menu, follow these
steps:

• Click Start | Settings | Control Panel.
• Click the Internet Options icon, and go to Step 3.

2222 Click the Tools menu, and then Internet Options.

3333 In the Internet Properties dialog box, click the Connections
tab.

4444 On the Connections tab, click the LAN Settings button.
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5555 In the Local Area Network (LAN) Settings dialog box, se-
lect Automatically detect settings and click OK.

Netscape Navigator

1111 On the desktop, click the Netscape Navigator icon.

2222 From the Edit menu, select Preferences.

3333 In the Preferences dialog box, click the Advanced option,
and then click Proxies.

4444 Select the option that allows you to connect to the Internet
directly.

AOL

AOL 5.0 or higher has a cable modem option that configures your
connection automatically.
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3
Using Your Cable Modem

Once you’ve installed your cable modem, connecting to the
Internet is as simple as clicking on the icon that corresponds to
the desired Internet application.

Connecting to the Internet
Once you have correctly installed the Zoom cable modem, it will
power up and synchronize itself with the cable network. The PWR
light, SYNC light, and 10BT light will light up, indicating that eve-
rything is complete. When you want to connect to the Internet,
start your browser or another Internet application.

Note: Your browser should be configured so that it connects via
a LAN. If you need help changing the way it connects,
turn to page 16.

The Zoom CM Monitor Utility
The Zoom CM Monitor Utility works with Windows
98/2000/Me/XP computers. It is automatically installed when you
install the cable modem software.

The utility is intended for both end users and cable service provid-
ers. It is meant to eliminate or decrease the number of cable com-
pany “truck rolls” and to save subscribers and service providers
time and money.

For end users installing the modem themselves, should a question
arise pertaining to the installation, the application can help during a
call to the cable company.
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Cable company field technicians can monitor the cable modem
during the range and registering portion of the installation and
quickly troubleshoot any problems encountered during the initial
setup process.

To access the CM Monitor, from the desktop click Start | Pro-
grams | Zoom Cable Modem | Cable Modem Monitor. Then
double-click the monitor icon in the system tray:

A dialog box similar to the one below displays.

The system tray icon (and the Status and Activity buttons) can be
one of three colors, indicating the modem’s connection status.

• Green: The modem is online and synchronized.

• Yellow: The modem is in the process of connecting.

• Red: Synchronization has been lost and the modem is trying to
connect.
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Depending on your cable modem model, you may be able to click
the More Details button for more technical information. The ta-
ble below defines this information. Most fields have “rollover” text
definitions: If you move your mouse over a field’s label, a defini-
tion of that field pops up.

Note: All these fields may not be visible for all cable modem
models.

Port Type Ethernet

Modem Status Online or Connecting

Traffic Meter:
CM to PC

The data rate, expressed in
bits/second, and the total amount
of data, expressed in bytes, from
the cable modem to the computer.

Traffic Meter:
PC to CM

The data rate, expressed in
bits/second, and the total amount
of data, expressed in bytes, from
the computer to the cable modem.

Reset Meter Clicking this button clears all traf-
fic fields.

Sync Status
Activity (ACT)

These lights indicate status and
any activity.

Hide Details Clicking this button closes the
more details screen.
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Connecting Status A text message that describes the
cable modem’s current mode.

C-MAC Address The cable modem’s MAC ad-
dress.

E-MAC Address The NIC card’s MAC address.

Serial Number The cable modem’s serial num-
ber.

Downstream Frequency (Hz) The frequency over which the
service provider’s head-end
transmits data to the cable mo-
dem.

Downstream SNR (dB) The signal/noise ratio (SNR) on
the downstream data channel,
from the service provider’s head-
end to the cable modem

Upstream Frequency (Hz) The frequency over which the
cable modem transmits data to
the service provider’s head-end.

TX Signal Level (dBmV) The cable modem’s transmit
power output level.

Firmware Version The cable modem’s firmware ver-
sion number.

Registration Phase As the modem completes each
stage of the registration process,
a checkmark appears in each box.
The Connecting Progress bar on
the bottom of the dialog box tracks
this progression: When all stages
are complete, the bar is solid, and
Modem Status is Online.

Right-clicking the system tray icon displays a brief menu of op-
tions. From here, you can

• Open the CM Monitor’s Status screen.

• Close the CM Monitor’s Status screen.

• Quit the CM Monitor application.

• Review information about the application.
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Ending an Internet Session
After you have completed your Internet session, close the browser
you are using. The Zoom cable modem will remain connected with
the cable system and will be ready to open another session.

If You Lose Power
If you unplug your cable modem, or if power is lost for any other
reason, all communication between the modem and the cable sys-
tem will be terminated. When the power is restored, the cable mo-
dem must go through the full startup and connection process be-
fore you can connect to the Internet. This process will be per-
formed automatically when the modem is powered up.

Note: Your cable company may request that you always keep
your cable modem on so that software maintenance can be
performed at night.

Removing Your Cable Modem
To remove your Zoom cable modem, follow these steps.

1111 Quit all running programs.
Note: This includes the CM Monitor Utility.

2222 Go to Start | Programs | Zoom Cable Modem and then
select Cable Modem Uninstall.

Click Next.
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3333 When the process is done, the following dialog box displays.

Be sure to remove any CD remaining in the computer and
then click Finish.

4444 Shut down your computer and unplug the cable modem
hardware.

Important: Be sure to unplug the cable modem hardware
before restarting your computer.

Note: The Resource Checker, User Manual, and complementary
software are also installed on your computer as part of the
cable modem installation process. When you perform the
instructions above, everything associated with your cable
modem is removed.
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Appendix A
Troubleshooting

This section provides tips to troubleshoot your cable modem in
the event of minor problems. By referring to these tips, you
may be able to quickly find a solution and avoid a call to
Technical Support or your cable service provider. You may also
want to refer to the Frequently Asked Questions, or FAQs,
located on the CD, or visit our Web site.

There is also a section describing our Zoom cable modem
Monitor Utility (see page 19). This utility is intended to help
technicians assist customers quickly and easily.

Note: If your cable modem is not responding, the first step
should be to reset it. This may take a few minutes, but it is
frequently the quickest and easiest solution.

IMPORTANT:
If your cable modem’s Ethernet interface is plugged into
one computer and you unplug it and plug it into another
computer, you must turn the modem off and then on
again. If you don’t, the modem will be unable to recognize
the new computer’s NIC card MAC Address, and will be
unable to assign IP address information to the computer
via DHCP.
You also may need to give your cable service provider the
new computer’s NIC card MAC address.
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Problem: I cannot access my Internet service or send or
receive email.

Solutions: Check all physical connections. The modem’s front
panel LEDs, SYNC, PWR, and 10BT, must all be a
solid green before your modem will work.
Check to see that your cable TV is working.

Call your cable service provider to verify that the cable
service is up and running.

Ethernet option users: Check that your NIC Card is
functioning correctly. Refer to the NIC documenta-
tion if necessary.

Check that TCP/IP is configured correctly. Refer to
page 29 to verify that the TCP/IP parameters supplied
by your cable company are correct and up to date.

Problem: The power to my cable modem goes on and off.
Solution: Check that you are using the correct power supply, the

one packaged with your cable modem.

If the modem is plugged directly into a wall socket,
check that the connection is secure.

If the modem is plugged into a power strip, try using a
different plug on the power strip, or plug the power
strip into a different wall socket.

Does the power loss occur at certain times of the day
or night? Cable service providers have the authority to
force a modem reset, which may resemble a power
off/on cycle.

Problem: I want to connect multiple PCs to my cable mo-
dem but I don’t know how.

Solution: There are numerous ways to do so—for example,
Zoom offers wireless and wired Gateway products
that serve this purpose—but you should first contact
your cable service provider.
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Problem: I receive the message “Unknown Network
Adapter.”

Solution: This problem can result if a NIC adapter is physically
present and recognized by Plug-and-Play, but the
proper drivers were not installed; Windows may have
added the device to the Other Devices list under De-
vice Manager. Reinstall the device.

Problem: I receive the message “Undetected Network
Adapter.”

Solution: The NIC adapter was not installed correctly. Reinstall
the device.

Problem: I receive the message “Missing Internet Proto-
col.”

Solution: Refer to page 29 for instructions on configuring net-
work settings.

Problem: I receive the message “Configure TCP/IP Failure
Error.”

Solution: Make sure that your Ethernet cable is plugged in: Un-
plug your modem from the electrical outlet for several
seconds, and then plug it back in. Be aware it will take
time for the modem to re-register itself and synchro-
nize itself with the cable system.

Problem: I receive the message “Cannot Find Files; Insert
Operating System Disk.”

Solution: Your computer is looking for the files included on the
original operating system CD or disks that came with
your computer. Remove your modem CD or disk (if
any) and insert your operating system CD or disk. Be
sure to remove the Windows CD when you’re done
and reinsert your modem CD or disk if applicable.
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Problem: The cable modem’s SYNC light blinks for 5 min-
utes, goes off, comes on again, and repeats.

Solution:     Make sure the connection is secure.

Check with your cable service provider to make sure
that high speed access is available and running.

In rare instances, the cable signal may be weak or
noisy. Be sure the modem is attached to one of the
ports on the first splitter after the cable enters your
home or office. Refer to the following diagram or
contact your cable provider.

Cable
M odem Com puter

TV #1

TV #2

2:1
Splitter

2:1
Splitter

Cable
Service

Cable
Ethernet
or USB

High
Pass

Am p

Make sure there is no video amplifier on the same line
with the cable modem. (A video amplifier prevents
data from returning to the cable service provider's
central office.)

Note: Sometimes, when your cable modem service is restored
after a disruption, you may experience difficulty communi-
cating. If this happens, disconnect and reconnect the
power, and let the modem perform the automated syn-
chronization process again.
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Appendix B
Windows 95, Macintosh, and

Linux Users: Configuring Your
Network Settings

If you are using the Windows 95 or Linux operating system, or
if you are using a Macintosh computer, you must ensure that
your computer’s network, or TCP/IP, settings are configured
correctly. Otherwise, you will not be able to connect to the
Internet. Windows 98, 2000, Me, and XP automatically
configure your network settings, so you don’t have to perform
this additional task.

• Windows 95 NeWindows 95 NeWindows 95 NeWindows 95 Nettttwork Settingswork Settingswork Settingswork Settings, page 30.
• Macintosh Network SettingsMacintosh Network SettingsMacintosh Network SettingsMacintosh Network Settings, page 32.
• Linux Network SettingsLinux Network SettingsLinux Network SettingsLinux Network Settings, page 36.
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Windows 95 Network Settings
To configure network settings on a computer running Windows
95, follow these steps.

Note: The screens depicted in these steps are representative of a
typical computer. Individual computer screens may vary.

1 Click Start | Settings | Control Panel and then double-click
the Network icon. The Network dialog box displays.

Click the Configuration tab. You will see a list of installed
network components. If you see a line that includes TCP/IP,
skip to Step 5. If you don’t see the line, continue with Step 2.

2 If you don’t see TCP/IP listed, click the Add button to display
the Select Network Component Type dialog box.

3 Click to highlight Protocol and click Add.

The Select Network Protocol dialog box displays.
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4 Click to highlight Microsoft and then click to highlight
TCP/IP in the Network Protocols list. Then click OK.

The Network dialog box from Step 1 displays. There should
now be an entry for TCP/IP. Click NO if you are asked to
restart your computer. Note: Don’t click OK yet.

5 Click to highlight TCP/IP and click Properties.

The TCP/IP Properties dialog box displays. Make sure you
are at the IP Address tab, and that Obtain an IP address
automatically is selected.
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6 You will see the Network dialog box again. Click OK to en-
able your settings.

If prompted to do so, insert your Windows 95 CD-ROM and
click OK.

If a dialog box appears indicating that it is necessary to restart
the computer, do so at this time.

This completes the installation of the modem. Most likely, your
web browser is set so that the cable modem connects to the Inter-
net correctly—it must connect via a LAN. If you need to adjust
your browser settings, however, turn to Chapter 2 (page 16) for
instructions. Otherwise, skip to Chapter 3 (page 19) to learn how
to get the most out of your modem.

Macintosh Network Settings
Depending on your Mac OS, the directions to configure your
Macintosh’s network settings will differ. For OS X, follow the in-
structions on page 35. Otherwise, continue directly below.

For Mac OS 7.6.1 - 9.2.2 and Above but not OS X

1111 From the Apple menu, choose Control Panels and then
TCP/IP to display the TCP/IP dialog box (you will use this
dialog box in Step 6).

2222 On the main toolbar, from the File menu, choose Configu-
rations.
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3333 In the Configurations dialog box, click Duplicate.

4444 The Duplicate Configuration dialog box appears. Type a
name, such as “Zoom Cable Modem,” and click OK.

5555 The Configurations dialog box appears again. Highlight
your new configuration—in our example, Zoom Cable Mo-
dem—and click Make Active.
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6666 In the TCP/IP dialog box, in the Connect via pop-up
menu, select Ethernet. In the Configure pop-up menu, se-
lect Using DHCP Server.
Do not enter anything in the DHCP Client ID field.

7777 Close the TCP/IP dialog box. You will be asked if you want
to save the changes. Click Save.

This completes the installation of the modem. Most likely, your
web browser is set so that the cable modem connects to the Inter-
net correctly—it must connect via a LAN. If you need to adjust
your browser settings, however, turn to Chapter 2 (page 16) for
instructions. Otherwise, skip to Chapter 3 (page 19) to learn how
to get the most out of your modem.
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For Mac OS X

1111 From the Dock, choose System Preferences and then
Network. The Network pane appears.

2222 From the Location: drop-down list box, select New Lo-
cation…. In the dialog box, type a name of your choos-
ing, such as “Zoom Cable Modem,” and click OK.

3333 Under the Configure drop-down tab, choose Built-in
Ethernet or Ethernet.

4444 Make sure that the TCP/IP tab is foremost and make
sure that Using DHCP is highlighted in its Configure:
drop-down list box. Do not enter anything into the
DHCP Client ID field.

5555 Click Save and close the Network pane.
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This completes the installation of the modem. Most likely, your
web browser is set so that the cable modem connects to the Inter-
net correctly—it must connect via a LAN. If you need to adjust
your browser settings, however, turn to Chapter 2 (page 16) for
instructions. Otherwise, skip to Chapter 3 (page 19) to learn how
to get the most out of your modem.

Linux Network Settings
The instructions for setting up boot-time DHCP vary dramatically
by distribution, so you may want to refer to your particular ver-
sion’s documentation. We have included instructions for RedHat,
SuSE, and Debian.

Note: If you have other network cards installed, you will need to
pick distinct Ethernet identifiers for each (eth0, eth1, eth2,
etc.). If you select an identifier other than eth0 for your
cable modem, use that identifier throughout.

For RedHat
Edit or create /etc/sysconfig/network-scripts/ifcfg-eth0 so
that it contains the following three lines:
DEVICE=eth0
ONBOOT=yes
BOOTPROTO=dhcp
Your computer should now come up on the cable network.

Note: If your computer won’t always be on a network with
working DNS at boot-time, set ONBOOT=no. If you
don’t, RedHat 6.2 (and possibly other versions) might
hang. To activate the card by hand when you have at-
tached your computer to the network, at root, run the
command: /sbin/ifup eth0.

For SuSE
Edit the file /etc/rc.config; search for the variables NETCON-
FIG, NETDEV_0, and IFCONFIG_0.
Set them as follows (see the instructions near each one in
rc.config):
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NETCONFIG="_0"
NETDEV_0="eth0"
IFCONFIG_0="dhcpclient"
Reboot with this command: /sbin/shutdown -r now.
Your computer should now come up on the cable network.

For Debian
Add the following line to the file /etc/network/interfaces: iface
eth0 inet dhcp.
Reboot with this command: /sbin/shutdown -r now.
Your computer should come up on the cable network.

This completes the installation of the modem. Most likely, your
web browser is set so that the cable modem connects to the Inter-
net correctly—it must connect via a LAN. If you need to adjust
your browser settings, however, turn to Chapter 2 (page 16) for
instructions. Otherwise, skip to Chapter 3 (page 19) to learn how
to get the most out of your modem.
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Appendix C
How To Locate Your Ethernet

MAC Address

If you are using the Ethernet port of your cable modem, you
must provide your cable company with your computer’s
Ethernet MAC address. If you are unsure how to determine this
MAC address, this Appendix explains how. The instructions
vary depending on your computer type and operating system.

For Windows 95/98/Me:
From the desktop, click Start | Run, type winipcfg, and click
OK. Click more info, then select the NIC card you are using. The
12-digit Adapter Address is your NIC card’s MAC address. Make a
note of it in the table on page 1.

For  Windows 2000/XP:
From the desktop, click Start |(All) Programs | Accessories |
Command Prompt. Then type ipconfig /all and press Enter.
Make a note of the 12-digit Adapter Address in the table on page 1.

For Windows NT:
From the desktop, click Start | Run | Programs | MS-DOS
Prompt. At the command prompt, type ipconfig/all and press
Enter. Make a note of the 12-digit Ethernet Adapter’s IP address
in the table on page 1.
For Macintosh Operating Systems:
Macintoshes are sold with an Ethernet ID label affixed to them. If
this label is missing from your Macintosh, you can determine the
E-MAC address by following the steps below.
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For Mac OS 7.6.1 - 9.2.2 and Above but not OS X:

1111 From the Apple menu, choose Apple System Profiler.

2222 In the Apple System Profiler window, click the Network
Overview arrow and then the AppleTalk arrow. Find the 12-
character Hardware Address (E-MAC address) and make a
note of it in the table on page 1.

For Mac OS X:

1111 From the Dock, choose System Preferences and then Net-
work. The Network pane appears.

2222 Under the Configure drop-down tab, choose Built-in
Ethernet or Ethernet.

3333 Make sure that the TCP/IP tab is foremost. Find the 12-
character Hardware Address (E-MAC address) and note it in
the table on page 1.

4444 Click Save and close the Network pane.
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Appendix D
Regulatory Information

FCC 47 CFR Part 15 Emissions Statement
This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to 47 CFR part 15 of the Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential in-
stallation. This equipment generates, uses and can radiate radio frequency and, if
not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular in-
stallation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following
measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Industry Canada Emissions Statement
This Class B digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement
sur le matériel brouilleur du Canada.

Electrostatic Discharge Statement
This unit may require resetting after a severe electrostatic discharge event.

Declaration of Conformity
The manufacturer declares under sole responsibility that European models of this
equipment comply to Directive 1999/5/EC (R&TTE Directive) via the following:

Directives Standards
73/23/EEC EN 60950 (1992) with the following

Amendments: A1, A2, A3, A4, and A11
89/336/EEC EN 55024 (1998)
89/336/EEC EN 55022 (1994) with Amendments A1, A2

The product is CE marked.
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This document contains proprietary information protected by copyright, and
this Manual and all the accompanying hardware, software, and documen-
tation are copyrighted. No part of this document may be photocopied or
reproduced by mechanical, electronic, or other means in any form.

The manufacturer does not warrant that the hardware will work properly in
all environments and applications, and makes no warranty or representa-
tion, either expressed or implied, with respect to the quality, performance,
merchantability, or fitness for a particular purpose of the software or docu-
mentation. The manufacturer reserves the right to make changes to the
hardware, software, and documentation without obligation to notify any
person or organization of the revision or change.

All brand and product names are the trademarks of their respective owners.

© Copyright 2002
All rights reserved.
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